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Le Model 2400 a des fonctions de controle de DAW. Si on le regle
en mode de contréle de DAW, ses commandes peuvent servir
aux opérations de base dans l'application DAW. Cela comprend
I'enregistrement, la lecture, I'arrét et d'autres fonctions de
transport.

Les émulations de protocole Mackie Control (MCU) et HUI

sont prises en charge, ce qui permet de contréler Cubase,
Digital Performer, Logic, Live, Pro Tools, Cakewalk et d'autres
applications DAW courantes.

Marques commerciales

® TASCAM is a registered trademark of TEAC Corporation.

® Microsoft and Windows are either registered trademarks or
trademarks of Microsoft Corporation in the United States
and/or other countries.

® Apple and Mac are trademarks of Apple Inc. in the United
States and other countries.

® Avid and Pro Tools are either registered trademarks or
trademarks of Avid Technology, Inc. or its subsidiaries in the
United States and/or other countries.

® Cubase are registered trademarks of Steinberg Media
Technologies GmbH.

® Cakewalk is a registered trademark are trademarks of
BandLab Technologies Inc.

® Other company names, product names and logos in this
document are the trademarks or registered trademarks of
their respective owners.
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Opérations sur le Model 2400

Préparation de I'unité

Branchement a un ordinateur

Reportez-vous a « Branchement d’un ordinateur » dans le
chapitre « 3 — Préparation » du mode d’emploi du Model 2400, et
branchez un ordinateur.

Consultez également le chapitre « 12 - Fonctions d'interface
audio USB » et faites les réglages.

Lancement du mode de controle de DAW

1. Enfonction de l'utilisation, réglez le sélecteur INPUT SEL sur
le Model 2400.

2. Quand l'enregistreur du Model 2400 est a l'arrét,
sélectionnez DAW CONTROLLER (controleur de DAW) en
écran MENU, et ouvrez I'écran MODE.

Pour des instructions d’utilisation, voir « Procédures
d'utilisation du menu » dans le chapitre « 2 - Nomenclature
et fonctions des parties » du mode d'emploi.

Réglez a I'avance le mode audio USB, la fonction de canal
de retour USB, I'écran MAIN REC POSITION et d’autres
parametres si nécessaire.

| mMooE |
MCU - Liw
HUI - Prn Tnnls
MEU - Cubsase
=5id I I

3. Sélectionnez le mode de contrdle de la DAW utilisée.
Pour plus de détails sur les réglages, voir le mode d’emploi
de l'application DAW utilisée.

Options : MCU - Live,
HUI - Pro Tools,
MCU - Cubase,
MCU - Cakewalk,
MCU - Logic,
MCU - DP,
MCU - Reaper,
MCU - Studio One,
MCU - Cubasis

4. Pressezla molette MULTI JOG.
Un message de confirmation apparaitra.

LAN COMTEOLLER
Start the DA

control ler mode.

Are wou sure 7

Pressez la touche F1 IIZEM pour revenir a I'écran MODE.

5. Pressezlatouche F4 IE=.

Cela ouvre I'écran DAW CONTROLLER et permet de faire
fonctionner la DAW.

DHN COMTEOLLER

MEU - Liwve

MARKER ——
B EEN

(Exemple d'écran avec « MCU - Live » sélectionné)

Sil'unité a été éteinte alors qu'elle était en mode de contréle
de DAW, elle retrouvera ce mode au redémarrage. Pour
I'utiliser en mode normal, quittez le mode de controle de
DAW avec la touche F1 IE3ad,

Abandon du mode de controle de la DAW

1. Pressezlatouche F1 pour afficher le message
suivant.

I DAW CONTEOLLER I

Are gou sure

to exit?

2. Pressez latouche F4 IEIZE0 pour mettre fin au contréle de
la DAW.

TASCAM Model 2400 Manuel du mode de contréle de DAW 3



Opérations sur le Model 2400

Réglages pour le son envoyé a l'ordinateur

Le son envoyé a l'ordinateur dépend des réglages des commutateurs INPUT SEL et REC OUT du Model 2400.

Pour plus de détails sur les réglages des commutateurs REC OUT, voir « Fonction des commutateurs REC OUT » sous « Fonctions de la
table de mixage (Mixer) » dans le chapitre « 9 — Autres fonctions » du mode d’emploi.

Commutateur REC OUT | COMP/EQ Sélecteur INPUT SEL | Son envoyé a l'ordinateur

MIC/LINE
Désactivé Désactivé USB Son arrivant aux prises d'entrée.

MTR

MIC/LINE Son arrivant aux prises d'entrée.
Activé (POST-EQ) Activé USB Son venant de l'ordinateur.

MTR Aucun son n'est envoyé a l'ordinateur.

4 TASCAM Model 2400 Manuel du mode de contréle de DAW



Opérations sur le Model 2400

Commandes utilisables en mode de controle de DAW

Les commandes suivantes du Model 2400 peuvent étre utilisées en mode de contréle de DAW.

® Les touches et la molette colorés en bleu dans l'illustration ci-dessous sont actifs.

Touche REC Elle peut servir a armer l'enregistrement.

Molette MULTI JOG Elle peut servir au repérage (a la localisation).

Leur fonction dépend de ce qu'affiche I'écran du DAW CONTROLLER.

Touches de fonction L
Pressez la touche MENU pour passer d'une fonction a l'autre.

TASCAM

Model 2400

S U
Ecran DAW CONTROLLER MARKER Ecran DAW CONTROLLER TRACK
DHW COMTEOLLER DHW COMTEOLLER
MCU - Liwve MCU - Liwve
MARKER —— o — TRACKE —
B SN cvoLf o= f = |
(Exemple décran avec « MCU - Live » sélectionné) (Exemple décran avec « MCU - Live » sélectionné)
@ Utilisez la touche F2 pour poser des marqueurs. ® Pressez la touche F2 IEXTEM pour changer la fonction de
< bouclage de la DAW.
® Avec les touches F3 IEZ3M et F4 BEEM, déplacez-vous entre
les marqueurs. ® Avec les touches F3 HEZE et F4 M=, déplacez-vous entre

les pistes qui peuvent étre controélées.

TASCAM Model 2400 Manuel du mode de contréle de DAW B



Réglages de diverses applications DAW

Pour permettre la réception de messages venant de I'application

DAW, faites d’abord passer le Model 2400 en mode de controle
de DAW, puis configurez I'application DAW.

Live

Windows
Les écrans suivants sont issus de la version 12.0.1 de Live.

1. Cliquez sur « Options » > « Préférences... »

#s Untitled - Ableton Live 12 Trial

File Edit Creste Playback View Naviga elp

RO sibility >
Edit MIDI Map. Ctrie M
Edit Key Map Ctrl-K
Computer MIDI Keyboard M

MIDI Editor Note Preview

~ Browser File Preview
External Sync
~  Delay Compensation
Reduced Latency When Monitoring

Time Ruler Format >
Narrow Grid Ctrie1
Widen Grid Ctrle2
Triplet Grid Ctrl+3
Snap to Grid Ctries
Snap Automation to Grid

Fixed Grid Ctrl+5
Draw Mode B
Step Input Mode Ctrl+ Shift+ B
Highlight Scales K

+  Chase MIDI Notes
~ MIDI Envelope Auto-Reset
Retune Set On Loading Tuning Systems

~  Solo Switches
Cue Switches

~  SoleinPlace

Lock Envelopes
MIDI Arrangement Overdub

Audio Engine On Ctrl+Shift+ Alt+E

Preferences... Ctrl+, l

2. Sélectionnez l'onglet « Link, TEMPO & MIDI », et réglez la
surface de contréle sur « MackieControl ».

e Preferences X

3. Réglezl'entrée sur « Model 2400 MIDI (Port 2) ».

e Preferences X

Model 2400 MIDI (Port 2) m

7] [None 7] [iene

4. Réglezla sortie sur « Model 2400 MIDI (Port 2) ».

MackieContral ¥ [Model 2400 MIDI (¥] [Mogel 2400 MIDI (¥] (Dump)

|
|| Mone
¥|| Microsoft GS Wavetable Synth

¥l Model 2400 MIDI (Port 2)
vg

La touche B du Model 2400 s'allumera, indiquant que la
télécommande est activée.
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Réglages de diverses applications DAW

Mac 4. Réglezla sortie sur « Model 2400 (DAW Control OUT1) ».
Les écrans suivants sont issus de la version 12.0.10 de Live.

1. Cliquez sur « Live » > « Préférences... »

}File Edit Create Playb

| Settings... 8,

Services

Hide Live ®¥H
‘Hide Others XH¥H
Show All

MackieControl  ¥| [Model 2400 (DAWY| [Model 2400 (DAWY/|
[None  v|[None ]

v Model 2400 (DAW Control OUT1) l
V| IVIVUET 254UV (DAY LOTIL I U 1 2]

v| [None hd

Quit Live

La touche M du Model 2400 s'allumera, indiquant que la
télécommande est activée.

2. Sélectionnez l'onglet « Link, TEMPO & MIDI », et réglez la

surface de controle sur « MackieControl ». Commandes utilisables avec la DAW

Les commandes suivantes du Model 2400 peuvent servir a faire
fonctionner I'application DAW.

® Touche F2 (écran DAW CONTROLLER MARKER)
e Touche F3 IEEEM (écran DAW CONTROLLER MARKER)
e Touche F4 HEEM (écran DAW CONTROLLER MARKER)
® Touche F2 IFFIsM (écran DAW CONTROLLER TRACK)
® Touche F3 BE=MM (écran DAW CONTROLLER TRACK)
e Touche F4 =M (écran DAW CONTROLLER TRACK)

lodel
[ g ® Molette MULTI JOG (fonction de repérage/localisation)

® Touches <<«/»>

® Touche B

® Touche »/11

® Touche @

® Touches REC (1-8)

L'armement de I'enregistrement (REC READY) peut étre
controlé pour 8 pistes. Pour utiliser la fonction dans un projet
ayant 9 pistes ou plus, pressez la touche MENU de I'unité et
ouvrez I'écran TRACK, puis utilisez les touches F3 HE=E et
F4 I pour accéder aux pistes souhaitées.

3. Réglezl'entrée sur « Model 2400 MIDI (DAW Control IN1) ».

Hide
1/2 v

Hide

MackieControl _¥||Model 2400 (DAW¥| [Model 2400 (DAWY/|
None v||None |
None ¥ |
None v | Model 2400 (DAW Control IN1) ‘ v|
None W — v|
None v||MIDI Keys hd
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Réglages de diverses applications DAW

Pro Tools

Les écrans suivants sont issus de la version 2024.6.0 de Pro Tools
12 Ultimate.

1. Cliquez sur « Setup » > « Peripherals... ».

@Y Pro Tools
File Edit View Tack Clip Event AudioSuite Options

B Edit: Untitled

Machine Track Arming Profiles...

Video Sync Offset...

Session Ctrl+ @
Current Eeet+Frames Position...
Current Timecode Position...

External Timecode Offset...

MIDI L4

Click/Countoff..
Keyboard Shortcuts...  Start+Shift+K

Preferences...

2. Sélectionnez l'onglet « MIDI Controllers », et réglez Type sur
«HUI ».

3. Réglez Receive From sur « MIDIIN2 (Model 2400 MIDI)
[Emulated] ».
Sur un Mac, réglez-le sur « Model 2400 DAW Control IN1 ».

Model 2400 MIDI [Emulated]

4, Réglez Send To sur « MIDIOUT2 (Model 2400 MIDI) [Emulated] ».
Sur un Mac, réglez-le sur « Model 2400 DAW Control OUT1 ».

ntrollers

ype

le Synth [Emulated]

DI) [Emulated]

5. Pourlarangée #2, réglez également Type sur « HUI »,
Receive From sur « MIDIIN3 (Model 2400 MIDI) [Emulated] »
et Send To sur « MIDIOUT3 (Model 2400 MIDI) [Emulated] ».

6. Cliquezsur « OK».

Peripherals %

La touche B du Model 2400 s'allumera, indiquant que la
télécommande est activée.

Commandes utilisables avec la DAW

Les commandes suivantes du Model 2400 peuvent servir a faire
fonctionner I'application DAW.

® Touche F2 (écran DAW CONTROLLER MARKER)
@ Touche F2 I=H=M (écran DAW CONTROLLER TRACK)

® Touche F3 IE=M (écran DAW CONTROLLER TRACK)

® Touche F4 IE=3M (écran DAW CONTROLLER TRACK)

® Molette MULTI JOG (fonction de repérage/localisation)
® Touches <«<«/»p>

® Touche W

® Touche » /11

® Touche @

® Touches REC (1-12, 13/14-19/20)

8 TASCAM Model 2400 Manuel du mode de contréle de DAW



Réglages de diverses applications DAW

Cubase

Les écrans suivants sont issus de Cubase 13.0.41.

1. Cliquez sur « Studio » > « Configuration du studio... ».

Cubase Pro Hub

File Edit Media Transporfl Studio §Vindow Help

Audio Connections... F4

MixConsaole F3
MixConsole 2
MixConsole 3
MixConsole 4
MixConsole in Project Window Alt+F3

Control Room

MIDI Remote Manager
VST Plug-in Manager

V5T Instruments F11
Audio Performance F12
Video Player F8
On-Screen Keyboard... Alt+K
Mare Options >

GoPro VR Player Remote
Head Tracking

l Studio Setup.. l

2. Cliquezsurle + en haut a gauche de la fenétre.

-
Studio Setup

Mackie Control

Note Expression Input Device

M User Commands

EuCon
JLCooper C5-10
JLCooper MCS-3000 Button Category Command
Mackie Baby HUI User A

Mackie Control User B
Mackie HUI

Fl

3. Sélectionnez « Mackie Control ».

Studio Setup X

Mackie Control

MIDI Input
Note Expression Input Device MIDI Output
Time Display

User Commands
EuCon
JLCooper C5-10
JLCooper MCS-3000 Button

User A

Command

User B

o - [al
Steinberg Houston

Tascam DM-24 (HUI)

Shift+F1

4. Réglezl'entrée MIDI sur « MIDIIN3 (Model 2400 MIDI) ».
Sur un Mag, réglez-la sur « Model 2400 DAW Control IN2 ».

Studio Setup

Mackie Control

Production

User Commands

Il faut d’abord régler « MIDIIN3 (Model 2400 MIDI) » ou
« Model 2400 DAW Control IN2 » sur un Mac.

5.

Réglez la sortie MIDI sur « MIDIOUT3 (Model 2400 MIDI) ».
Sur un Mag, réglez-la sur « Model 2400 DAW Control OUT2 ».

Mackie Control

MIDI Input
MIDI Output
User Commands

Model 2400 MIDI

MIDIOUT3 (Mode! 2400 MIDI)

Button Category

6. Répétez l'opération a partir de I'étape 2, en réglant I'entrée
MIDI sur « MIDIIN2 (Model 2400 MIDI) » et la sortie MIDI sur
«MIDIOUT2 (Model 2400 MIDI) ».

Sur un Mag, sélectionnez respectivement « Model 2400
DAW Control IN1 » et « Model 2400 DAW Control OUT1 ».

7. Cliquez sur « OK».

Studio Setup X

8.

Mackie Control

| Mixer ASIO User Commands

@ MDI tup
[ MIDI Remote

Button Cate Command
User A

User B

Fl

Shift+F1

shift+F2

F3

shift+F3

F4

Shift+F4

Short

Retournez dans « Studio Setup... » et cliquez sur
« Configuration des ports MIDI ».

Studio Setup

MIDI Port Setup
Device (Vo]
Windows MIDI
Windows MIDI
Windows MIDI
Windows MIDI

Windows MIDI

TASCAM Model 2400 Manuel du mode de contréle de DAW 9



Réglages de diverses applications DAW

9. Décochez les cases « MIDIIN2 (Model 2400 MIDI) » et ops
< MIDIINS (Model 2400 MIDI) ». ’ Commandes utilisables avec la DAW

Les commandes suivantes du Model 2400 peuvent servir a faire
fonctionner I'application DAW.

® Touche F2 (écran DAW CONTROLLER MARKER)
® Touche F3 23 (écran DAW CONTROLLER MARKER)
® Touche F4 BEEH (écran DAW CONTROLLER MARKER)
@ Touche F2 IEH=M (écran DAW CONTROLLER TRACK)
e Touche F3 IEZM (écran DAW CONTROLLER TRACK)

® Touche F4 IEZM (écran DAW CONTROLLER TRACK)
® Molette MULTI JOG (fonction de repérage/localisation)
® Touches <«/>p

® Touche H

10. Cliquez sur « OK ». ® Touche > /11

® Touche @

® Touches REC (1-12, 13/14-19/20)

MIDI Port Setup

Studio Setup x

EEEEEE

La touche B du Model 2400 s'allumera, indiquant que la
télécommande est activée.

Il peut étre nécessaire de faire redémarrer Cubase en
fonction de la configuration de l'ordinateur sur lequel il se
trouve.

10 TASCAM Model 2400 Manuel du mode de contréle de DAW



Réglages de diverses applications DAW

5.
Cakewalk
Les écrans suivants sont issus de la version 2024.02 (Build098)
de Cakewalk.
1. Cliquez sur « Edition » > « Préférences... ».
u Cakewalk _ [Untitled Project1] +
iews Insert Process Project Utilities Window Help
Bosty B save Import Preferenc
Redo Ctrl+Y, Ctrl+Shift+Z
i Open Tracks Synth
History...
art Screen  Fit Project Keyboard
Select L4
iew - Options = Tracks
Aim Assist L4
Cut
Cut Special... Arranger Track 1
- 6.
‘ Copy Special...
Paste

Paste Special...
Delete

0 -None- ¥ [DMaster

Delete Special...

@ ™MDl

M
- I |

2. Sélectionnez « Surfaces de controle ».
Preferences X
Audio Select any control surface(s) you want to use in Cakewalk.
X ]
Driver Settings
Playback and Recarding Controller fSurface In Port Out Port A . WAl color
Configuration File
Syncand Caching
MIDI
Devices
Playback and Recording Refresh Frequency (millise conds} 75 a
=
.
File
3. Cliquez sur I'étoile en haut a droite de la fenétre.
Preferences X
Audio Select any control surface(s) you want to use in Cakewalk.

Devices

Impart ACT Data

Driver Settings Connected Conbrollers/Surfaces

Playback and Recording PP

In Port Out Part AL WL WAl color
Configuration File
sync and Caching

MiDI

Devices

Playback and Recording Ratresh Freq

yGniliseconds) 75 #

Instruments

WAl plas Control Stiips Visible in:
[ conteatsurtaces ] Track Ve (2 Donsole View Orsckivisn O oansale e QAL Strps

Drum Map Manager

File

4. Réglez Controleur/Surface sur « Mackie Control ».

Controller/Surface Settings

Cantraller/Surface

| [ACT MIDI Contraller v |

ALCT MIDI Contraller Cancel .
Cakewalk Genenc Surface

b ackie Contral C4 Help
bd Lt T mim ke WA T
- Maone - £ MIDI Devices...

Réglez le port d'entrée sur « MIDIIN2 (Model 2400 MIDI) ».

Controller/Surface Settings x
Controller/Surface

M ackie Control e |

Cancel ,

|nput Port

- Mane - ~ e

- Mone -

MID M2 [Mode MID| Devices

I L N N N =y [

Réglez le port de sortie sur « MIDIOUT2 (Model 2400 MIDI) ».
Controller/Surface Settings X
ControllerdSurface

kackie Cantral L

Cancel

[rpLit Part

MIDIINZ (Model 2400 MIDI ~ ach
Cutput Part

|MIDIEILIT2 [Model 2400 M| - MIDI Devices...

- Maone -

b o] AT kAT X
[ e N e e =N

Cliquez sur « OK ».
Controller/Surface Settings =

Cantraller/Surface

tackie Control

[nput Part

MIDIINZ [Madel 2400 MIDI Help
Output Part

MIDIOUT 2 (Model 2400 M1 - MIDI Devices...

Répétez l'opération a partir de I'étape 3, en réglant le port
d’entrée sur « MIDIIN3 (Model 2400 MIDI) » et le port de
sortie sur « MIDIOUT3 (Model 2400 MIDI) ».

La touche B du Model 2400 s'allumera, indiquant que la
télécommande est activée.
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Réglages de diverses applications DAW

Commandes utilisables avec la DAW

Les commandes suivantes du Model 2400 peuvent servir a faire
fonctionner I'application DAW.

® Touche F3 IEZEM (écran DAW CONTROLLER MARKER)
® Touche F4 HEEM (écran DAW CONTROLLER MARKER)
@ Touche F2 IEXTEM (écran DAW CONTROLLER TRACK)
® Touche F3 IE=MM (écran DAW CONTROLLER TRACK)
® Touche F4 MEE3M (écran DAW CONTROLLER TRACK)
® Molette MULTI JOG (fonction de repérage/localisation)
® Touches <«/»>

® Touche B

® Touche > /11

® Touche @

® Touches REC (1-12, 13/14-19/20)

12 TASCAM Model 2400 Manuel du mode de contréle de DAW



Réglages de diverses applications DAW

Logic Pro

Les écrans suivants sont issus de la version 11.0.0 de Logic Pro.

1. Cliquez sur « Logic Pro » > « Réglages » > « Surfaces de
controle... ».

File Edit Track Navigate Rec Mix  View  Window

About Logic Pro L

Settings | General...

Audio...
Key Commands >  Recording...
: | MIDL...
Sound Library >
4 ¢ Score...
Provide Logic Pro Feedback

N Movie...
Learn About Logic Remote... -

Learn About MainStage...
A Control Surface:
Services >

My Info...

Hide Logic Pro #®H

N Advanced...
Hide Others X#H .
Show All Reset All Settings Except Key Command Assignments..

Quit Logic Pro %0 Plug-in Manager...

2. Cliquez sur « Configuration... ».

o Settings
® HOBH S ® © &
General Audio Recording MiDI Score Movie Automation  Control Surfaces View My Info  Advanced
General  Help Tags  MIDI Controllers
Bypass all while in background
Resolution of Relative Controls: v 128 A
Maximum MIDI Bandwidth: v 50 ~ %

Touching fader selects track
Control surface follows track selection
Jog resolution depends on horizontal zoom
Pickup mode
Flash Mute and Solo buttons
Multiple Controls per Parameter: 2 @
For Longer Labels and Value Displays
Only when all parameters fit on one page
Show Value Units For: 2 Instrument/plug-in parameters
Volume and other parameters

Controller Assignments...

3. Cliquez sur « Nouvelle » > « Installation... ».

ogicPro File Edit Track Navigate Recol Mix View Window Help

Edit ~ [ (New

v
> Region: Audio Del

"L v Automatic Installation
> Track: Audio 1 Move the pointer over an item to snow its name and function. To hide or

4. Sélectionnez « Fabricant : Mackie Designs » et « Modele :
Mackie Control », et cliquez sur « Ajouter ».

[ ] L] Install
Manufacturer ~  Medel Plug-in / Profile Version
M-Audio Oxygen 25 mkIV Oxygen 25 mkIV
M-Audio Oxygen 49 Oxygen 49
M-Audio Oxygen 49 mkiV Oxygen 49 mkIV
M-Audio Trigger Finger Trigger Finger
M-Audio (Midiman) iControl iControl 11010
Mackie Designs Baby HUI HUI 24710
Mackie Desians HUI HUI 24710

Mackie Designs Mackie Control 25910
Mackie Designs Mackie Control Extender  Logic Control 25910
Mackie Designs Mackie Control Extender... Logic Control 255910
Mackie Desians MCLU Pro I ogic Control 2 59r0

Q Scan All

5. Pour Périphérique : Mackie Control, réglez le port de sortie
sur « Model 2400 DAW Control OUT1 ».

& logicPro File Edit Track Navigate Record Mix View Window 1 Help
Control Surface Setup

y V' Quick Help
gion: Audio Def
Welcome to Quick Help
Track: Audio 1 Move the pointer over an item to show its name and function. To hide or
show Quick Help, choose Help > Quick Help or click the 2 button in the
control bar.

3 All
Mackie Control

Output Pf | v Model 2400 DAW Control OUT1 8 Mackie Control

Input P!

Module Logic Pro Virtual Out

6. Pour Périphérique : Mackie Control, réglez le port d’entrée
sur « Model 2400 DAW Control IN1 ».

gicPro  File Edit Track Navigate Record Mix View Window Help
® Control Surface Setup

Edit © New -

Ny V' Quick Help
> Region: Audio Def
Welcome to Quick Help
: Audio 1 Move the pointer over an item to show its name and function. To hide or
show Quick Help, choose Help > Quick Help or click the ? button in the
control bar.

v Device: Mackie Control
Any
Output P 8 Mackie Control

Input Pq | v Model 2400 DAW Control IN1

Mol
MIDI Keys

7. Répétezl'opération a partir de I'étape 4, en réglant le port
de sortie sur « Model 2400 DAW Control OUT2 » et le port
d'entrée sur « Model 2400 DAW Control IN2 ».

8. Pour Mackie Control #2 défini a I'étape 7, réglez « Décalage
des banques de curseur » sur « 8 ».

Track Navigate Record

v Quick Helf

> Region: Audio Def 2
Live Loops Scene Offset field

> Track: Audio 1 Sets the Live Loops scene offset for the device within a control surface
aroup. The offset determines which scenes the device's scan buttons
contral
Press %] for moreinfo.

' Device: Mackie Control #2

Mackie Control .

o input1

Stereo Out

La touche B du Model 2400 s'allumera, indiquant que la
télécommande est activée.
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Réglages de diverses applications DAW

Commandes utilisables avec la DAW

Les commandes suivantes du Model 2400 peuvent servir a faire
fonctionner I'application DAW.

@ Touche F2 I=H{=M (écran DAW CONTROLLER TRACK)

® Touche F3 IEZM (écran DAW CONTROLLER TRACK)

® Touche F4 M= (écran DAW CONTROLLER TRACK)

® Molette MULTI JOG (fonction de repérage/localisation)
® Touches <«<«/»>

® Touche W

® Touche »/1l

® Touche @

® Touches REC (1-12, 13/14-19/20)
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Réglages de diverses applications DAW

DP (Digital Performer)

Les écrans suivants sont issus de Digital Performer 10.1.

1. Cliquez sur « Setup » > « Control Surface Setup... ».

@ Mode-12 DAW CONTROLLER SETTING

File Edit View Region Audic Project Studi Lt Window  Help

W Command... Shift-Space
Commands Shift-L

o« Hl >l
S sl & bt Wi bt @ 2

Input Filter...
Event Chasing..

Automation Setup...

Legend...

Time Formats Ctrle Ale=T

Frame Rats
Receive Sync...

Transmit Sync...

Control Surface Setup...

Audio System
Configure Audio System
Audio System Clock

Listan to con

1o add a driver o your configuration.

Cancal

3. Réglez I'unité sur « Mackie Control ».

Control Surface

. Mackie Control 2RI

Note: I

4, Réglezle port d'entrée sur « MIDIIN2 (Model 2400 MIDI)
[Emulated] ».
Sur un Mag, réglez-le sur « Model 2400 DAW Control INT ».

TASCAM IXR (Missing)
US-322 (Missing)
US-366 (Missing)
US-1800 (Missing)
US-122 MKII (Missing)

Madel 12 DAW Control IN-16

5. Réglezle port de sortie sur « MIDIOUT2 (Model 2400 MIDI)
[Emulated] ».

Sur un Mac, réglez-le sur « Model 2400 DAW Control OUT1 ».

43
a0
45

—— — -
Lo e Pt : l m

[ = f AP LR
¥ Model 12 DAW Control OUT
Wk e
TASCAM iXR (Missing)
US-322 (Missing)
US-366 (Missing)
US-1800 (Missing)

US-122 MKII (Missing)
US-144 MKII (Missing)
US-16x08 (Missing)
US-20x20 (Missing)
1G-2v? FMissina)

6. Cliquezsur « OK».

Control Surface

7. Cliquezsur le [+] a droite du champ de port de sortie pour
ajouter une unité « Expander (XT) ».

8. Réglezle port d'entrée sur « MIDIIN3 (Model 2400 MIDI)
[Emulated] » et le port de sortie sur « MIDIOUT3 (Model
2400 MIDI) [Emulated] ».

La touche B du Model 2400 s'allumera, indiquant que la
télécommande est activée.

Commandes utilisables avec la DAW

Les commandes suivantes du Model 2400 peuvent servir a faire
fonctionner l'application DAW.

@ Touche F3 IEZM (écran DAW CONTROLLER MARKER)
® Touche F4 IEEH (écran DAW CONTROLLER MARKER)
@ Touche F2 I==M (écran DAW CONTROLLER TRACK)
® Touche F3 IEZM (écran DAW CONTROLLER TRACK)
e Touche F4 =M (écran DAW CONTROLLER TRACK)
® Touches <<«/»>

® Touche H

® Touche > /11

® Touche @

® Touches REC (1-12, 13/14-19/20)
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Réglages de diverses applications DAW

Cubasis

Les écrans suivants sont issus de la version 3.3 de Cubasis.

ATTENTION

Les versions 3.3 et ultérieures de Cubasis sont prises en
charge.

1. Cliquez sur « SETUP » > « MIDI ».

aYER| ?

SHOP SETUP HELP

Project MIDI Input Only for Armed Track
General
Audio Note Coloring
MIDI
Keys/Pads MIDI over Bluetooth
R Metronome Host

Mixdown / Freeze

2. Cliquez sur « Ports » sous « Mackie Control/HUI » dans la

fenétre.

MIDI Learn
(U]
Mackie Control / HUI

Send MIDI Clock

3. Dans lafenétre Select Mackie/HUI Ports, cliquez sur « Model
2400 DAW Control IN1 », « Model 2400 DAW Control
IN2 », « Model 2400 DAW Control OUT1 » et « Model 2400
DAW Control OUT2 », et réglez chacun d’eux sur « Mackie
(1-8) » ou « Mackie (9-16) » comme ci-dessous.

Select Mackie / HUI Ports

4. Activez l'icéne figurant dans le cadre rouge.

Mackie Control / HUI

Port

La touche B du Model 2400 s'allumera, indiquant que la
télécommande est activée.

Commandes utilisables avec la DAW

Les commandes suivantes du Model 2400 peuvent servir a faire
fonctionner l'application DAW.

@ Touche F2 IFXTEM (écran DAW CONTROLLER TRACK)

® Touche F3 BE=MM (écran DAW CONTROLLER TRACK)

® Touche F4 IEEM (écran DAW CONTROLLER TRACK)

® Molette MULTI JOG (fonction de repérage/localisation)
® Touches <«<«/»>

® Touche H

® Touche > /11

® Touche @

® Touches REC (1-12, 13/14-19/20)
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Réglages de diverses applications DAW

Studio One

Les écrans suivants sont issus de la version 6.6.1 de Studio One.

1. Cliquez sur « Studio One » > « Options... ».

= studio One -
File Edit Song Tack Event Audio Transport Viey

3tuaio One Activation...

Studio One Installation...
Backup and Restore...
Activate Purchased ltems..
Sign out (tascam_rchi@teac.cojp)
% SoundCloud Client
(® TuneCore Client

7 Macro Organizer

Language

2. Cliquezsur l'icone « Périphériques externes » en haut de la
fenétre, puis sur « Options ».

Bl Opticns x

®;

General Audio Setup External Devices

Send To Receive From

3. Sélectionnez « Ajouter... » et ouvrez « Mackie » > « Control ».
_l Add Device X

Macki
Mackie

Control

1 Instruments

Receive From

Send To

Send M

4. Réglez « Recoit de » sur « MIDIIN2 (Model 2400 MIDI) ».
Sur un Mag, réglez-le sur « Model 2400 DAW Control IN1 ».

ive From MIDIIMNZ {(Model 2400 MIDI)

" MIDIMNZ (Model 2400 MIDI)

5. Réglez « Envoie a » sur « MIDIOUT2 (Model 2400 MIDI) ».
Sur un Mag, réglez-le sur « Model 2400 DAW Control OUTT ».

Receive From MIDIIMNZ (Model 2400 MIDI)

Send To
nd MIDI

Use MIDI Clo

Send MIDI Tim

6. Cliquezsur « OK».

Bl Opticns x

®;

General Audio Setup External Devices

Send To Receive From

M MIDIIN2

Add Edit

are unavailable when Studio O

+ | Notify me if

Options

La touche B du Model 2400 s’allumera, indiquant que la
télécommande est activée.
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Réglages de diverses applications DAW

Commandes utilisables avec la DAW

Les commandes suivantes du Model 2400 peuvent servir a faire
fonctionner I'application DAW.

® Touche F2 (écran DAW CONTROLLER MARKER)
® Touche F3 23 (écran DAW CONTROLLER MARKER)
e Touche F4 HEEM (écran DAW CONTROLLER MARKER)
(
(

@ Touche F2 IEH{=M (écran DAW CONTROLLER TRACK)

e Touche F3 IEZM (écran DAW CONTROLLER TRACK)

® Touche F4 BE=3M (écran DAW CONTROLLER TRACK)

® Molette MULTIJOG (fonction de repérage/localisation)
® Touches <«/pp

® Touche B

® Touche & /11

® Touche @

® Touches REC (1-8)

L'armement de I'enregistrement (REC READY) peut étre
controlé pour 8 pistes. Pour utiliser la fonction dans un projet
ayant 9 pistes ou plus, pressez la touche MENU de I'unité et
ouvrez I'écran TRACK, puis utilisez les touches F3 IE=M et
F4 I pour accéder aux pistes souhaitées.
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Réglages de diverses applications DAW

REAPER

Les écrans suivants sont issus de la version de REAPER du 26 juin

2024.

1. Cliquez sur « Options » > « Préférences... ».

File Edit View Insert

-

ROUTE

G REAPER v7.17 - EVALUATION LICENSE

Item  Trac|

Yerd mode: normal
Record mode: time selection auto punch
Record mode: auto-punch selected items

Overlapping recording behavior
Offset overlapping media items vertically

Auto-crossfade media items when editing
Trim content behind media items when editing

Always trim content behind razor edits

Show all takes (when reom)

Take behavior

Ripple edit per-track
Ripple edit all tracks

Item grouping and track razor/edit grouping enabled
Loop points linked to fime selection

Snap/grid

Locking

Envelope points

Automation items.

Razor edits

Metronome enabled

Metronome/pre-roll settings...

Solo in front

Pre-fader track metering

Show FX inserts in TCP {when size permits)
Show sends in TCP (when size permits)

Peaks display mode

Automatically scroll view during playback
Continuous scrolling

Smooth seeking (seeks at end of measure)

Chase MIDI note-on/CC/PC/pitch in project playback

Extemal Timecode Synchronization

Show REAPER resource path in explorer/finder.
Customize menus/toolbars...

Themes

Alt+X

Carl+L

Alt+Shift+G

Preferences...

2. Cliquez sur « Ajouter » dans la fenétre « Control surfaces/

0SC/web control ».

) REAPER Preferences

Zoom/Seroll/Ofiset
Envelope Colors
Editing Behavior
Envelope Display
Automation
Automation lems
Mouse
Mousze Modifiers
MIDI Editor
Media
MIDI
Feaks Generation
Video
Impart
Plug-inz
Compatibility

Control surfaces/050/web contral

add

Contral surface display update frequensy 15

Edit Remave

Hz (de fault: 153

[) Warn when errors opening surface MIDI devices
[[)Dlose contral surfsce devices when stopped snd not active spplication
[[JGlose contral surfice devices when rendring

(changes will be spplied immediate )

Cancel Agply

3.

Pour le « Mode de la surface de contréle », sélectionnez
« Mackie Control Universal » et cliquez sur « OK ».

Medi Web browser interface

v =iy

ontrol Surface Settings X

Cantrol surface mode.

Ehrincar BOF 2000 (4sing prezet |
Frontier AlphsTrack

Frontier Tranzport

HUI (partial)

reEanus FadarFort
i FreSonus FaderPort v2 (2018)

VAMAH 01 X

Oancel
s Apply

ring e

4.

Réglez « MIDI input » sur « MIDIIN2 (Model 2400 MIDI) », et
réglez « Surface offset (tracks) » sur « 0 ».
Sur un Mac, réglez-le sur « Model 2400 DAW Control IN1 ».

[o— ®
o & Control Surface Settings x
Za
£o Control surfcs moda:  Mackis ontral Uniwerssl ~
Eitit
B MID! input ~]
A MID! outpu g
aul
Mo Surface offset (racks
Ma Size tweak: [Virtual MIDI Ke yboard
it

o

Medi

e [)lenors slobsl bank offse ts (slwsys msp to tracks specified)
vid
Im
Plug:
Cao

L
Re|

GCani
Exde|

[]lgnore fader moves when fader is not being touched
af [ Map F1-F8 40 60 to markers

Oancel
s Apply

ring o

5.

Réglez « MIDI output » sur « MIDIOUT2 (Model 2400 MIDI) ».
Sur un Mac, réglez-le sur « Model 2400 DAW Control OUT1 ».

0

& Control Surface Settings 4
Zon
En Control surface mode: Mackie Contral Universal v
Editit
En' MIC! input: MIDINZ (Model 2400 MIDI) v
Au MIDI output: | -

A
Mone
Li:| SR Gk EiE |Mlcmsnﬂ 55 Wawetable Synth

Ma Size tweal
it
Megi | tEnore fader moves

Wit [ Map F1=F& to go to markers,
Pe| [JlEnore elobal bank offsets Calways ek to tracks specified)

v =iy

Sond
Exte

Cancel

rina wr

T —

Répétez I'opération a partir de I'étape 2, en réglant « MIDI
input » sur « MIDIIN3 (Model 2400 MIDI) » et « MIDI output »
sur « MIDIOUT3 (Model 2400 MIDI) ». Réglez « Surface offset
(tracks) » sur « 8 ».

Sur un Mag, sélectionnez respectivement « Model 2400
DAW Control IN2 » et « Model 2400 DAW Control OUT2 », et
réglez « Surface offset (tracks) » sur « 8 ».
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Réglages de diverses applications DAW

7. Cliquez sur « OK ». ope
a R Commandes utilisables avec la DAW

[ @ rearen pefeences = x| Les commandes suivantes du Model 2400 peuvent servir a faire
EDDTIEG?YDK?‘ Control surfaces/ 050/ web cantrol fOnCtiOn ner |’app|ication DAW.
Envioe Dl ® Touche F2 (écran DAW CONTROLLER MARKER)
%LZ":M ® Touche F3 IEZEM (écran DAW CONTROLLER MARKER)
i @ Touche F4 BEEE (écran DAW CONTROLLER MARKER)
MIDI
g et @ Touche F2 IEX=M (écran DAW CONTROLLER TRACK)
Plucins o Touche F3 HE=Ml (écran DAW CONTROLLER TRACK)
wsT Edit Remaowe (changes will be spplied imme diately) ,
LuoLae Contrcl surface dispay updale fequency. 15 H Gt 15) @ Touche F4 IE= (écran DAW CONTROLLER TRACK)
ReWire /DX (T)Wam when errors opening surfice MID! devices
JFessawt Qe ot Zp s hen g ndnt it s ® Molette MULTI JOG (fonction de repérage/localisation)
Externsl Em«:’; — - » ° Touches << / >
® Touche H
La touche M du Model 2400 s'allumera, indiquant que la e Touche » /11
télécommande est activée.
® Touche @

® Touches REC (1-12, 13/14-19/20)
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Tableau d’équipement MIDI

Tableau d’équipement MIDI - Ports de controle de DAW

Fonction Transmis Reconnu Remarques
Par défaut X X
Canaux de base -
Modifiable X X
Par défaut X X
Mode Messages X X
Modifie |
i Plage (@) (@) Mode HUI : test de liaison
Numéros de note -
Plage O O Mode Mackie Control : touche, LED
Enfoncement
© O Mode HUI : test de liaison
. Relachement X X
Dynamique
Enfoncement (@) (@) .
Mode Mackie Control : touche, LED
Relachement X X
Polyphonique X X
Aftertouch yp g
Par canal X X
Pitch bend O X Mode Mackie Control : fader
(@) (@) Mode HUI : LED, commutateur
Changement de commande
(@) (@) Mode Mackie Control : encodeur
Changements de X X
programme Plagederéglage |ae |
Messages exclusifs de systéme (@) (@) Mode Mackie Control
Position X X
Messages communs de Sélection de morceau X X
systeme Quart d'image X X
Accord X X
i Horloge X X
Messages en temps réel
Commande X X
Local on/off X X
Coupure de toutes les % %
Autres notes
Test de liaison X X
Réinitialisation X X
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